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These instructions
are for all pages of

your cookbook: Title 
Page, Special Pages,

Table of Contents, Recipe 
Pages, etc.

You may use this
guide for submitting
dividers if they are

regular (not tabbed) and 
if the art does not bleed. 

Otherwise, call
us for assistance.

WHAT IS
PRESS-READY?

Press-ready material 
requires no typesetting 

or alterations. The mate-
rial will go directly from 

computer to press.
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TO SUBMIT A PRESS-READY COOKBOOK:
There are two press-ready options available when submitting your cookbook:

OPTION 1    Cookbook pages submitted as digital files created on a
Macintosh® or PC platform, with no manipulation required, ready to be 
output to plate. A hard copy must accompany the disk (for proofing purposes 
only). Digital files are preferred because the print quality is superior to a 
hard copy. Files can be sent as QuarkXpress®, PageMaker®, or PDF files. 
Artwork and photos must be included with the files. (See page 2.)

OPTION 2    Cookbook pages submitted as a hard copy. These must be 
clean, sharp, white pages printed with black toner, at the proper size (100%). 
All artwork should be at the correct size, pasted into position on the pages. 
Photos should not be pasted onto pages because halftones must be created. 
(See page 3.)

Material not press-ready includes: color printouts, dot matrix printouts, 
paper plates, digital files that don’t follow our specifications, or pages created 
with wrong image area and margins. If this material is submitted, pages will 
be returned to the customer for corrections.

PROOFS
A free proof will be created for approval when press-ready pages are sub-
mitted. Production will continue when the proof has been approved.

Press-Ready
Cookbook Page Guidelines



It is essential that these 
policies and procedures 

are followed closely; 
failure to do so may
delay the production

of your order.

And remember,
we’re always just a phone 

call away if you have a 
question or need 

assistance.

Include all pages of your cookbook, e.g., Title Page, Special Pages, Table of Contents, 
Recipe Pages, Index, etc. Do NOT submit dividers with these pages—keep them 
separate.

ACCEPTED SOFTWARE & MATERIAL
Digital files will be accepted if they are created on a Macintosh® or PC platform using 
ONLY the following software:
• QuarkXPress® 3.3 or newer for Mac® or IBM®

• PageMaker™

•  PDF (Portable Document Format) PDF files are preferred over Quark® or Page-
Maker® because data conversion errors are minimal. For information, go to the 
download center on our website and print “Creating PDF Files.”

•  Include your document, all your fonts (in a Fonts Folder) and photos/artwork (in an 
Art Folder). If your document is converted to a PDF file, fonts, photos or artwork 
are not needed since they are embedded into the file.

•  Put files on a 3.5” diskette, an Iomega® Zip™ or Jaz™ cartridge, or a standard CD.
•  Label the disk, cartridge or CD with your organization’s name, book title and type 

of file (software used to create).
•  A hard copy of the entire book (printed from the file on the disk you submit) must 

be submitted for proofing purposes. (See page 5.)

PAGE SETTINGS & MARGINS
•  When setting up your document, page size should be  5.5” width x 8.5” height. 

Check the Facing Pages box and set the top, bottom, and outside margins at .375” 
(3/8”). Inside margins must be set at .75” (3/4”), to accommodate the binding. 

•   All text (including page numbers), artwork, and photos must stay within these 
margins.

DOCUMENT SPECIFICATIONS
•  All pages of the book must be in one document. DO NOT place each section in a 

separate document.
•  Photos and artwork should be scanned and saved at the size they will be used in 

QuarkXPress® or PageMaker®, not scaled in the Measurements palette. (See 
pages 7-10.) Picture box specifications should show all artwork at 100%.

•  Do not rotate or flip artwork in QuarkXPress®, but rather in the graphic software it 
was created in, such as Photoshop™.

•  Do not apply a “style” to type in the Measurements palette of QuarkXPress®. 
Select the actual typestyle from the font menu. Check Font Usage (if using 
QuarkXPress®) to ensure all fonts are being used in this manner.

•  All text, line art, and photos should be in black (or grayscale). DO NOT assign a color 
to anything.

Submitting Pages
as Digital Files
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It is essential that these 
policies and procedures 

are followed closely; 
failure to do so may
delay the production

of your order.

And remember,
we’re always just a phone 

call away if you have a 
question or need 

assistance.

Include all pages of your cookbook, e.g., Title Page, Special Pages, Table of Contents, 
Recipe Pages, Index, etc. Do NOT submit dividers with these pages—keep them 
separate.

Carefully follow the Printing a Hard Copy guidelines on page 4.

PAGE SETTINGS & MARGINS
•  Image area is 4.375” x 7.75” (43/8” x 73/4”).
•  All text (including page numbers), artwork, and photos must stay within the image 

area shown on Figures A and B on page 4.
•  Submit the pages one of three ways: 

1.  Position pages on 8.5” x 11” sheets of paper with top and bottom margins set at 
1.625” (15/8”) and left and right margins set at 2.0625” (21/16”). See Figure A on 
page 4.

   2.  Position 2 facing pages on 11” x 8.5” sheets. Set top, bottom, and outside 
margins at .375” (3/8”) and place a 1.5” (11/2”) gutter between the image areas. 
See Figure B on page 4.

   3.  A different template may be used as long as the actual image area is 
4.375” x 7.75” (43/8” x 73/4”).

PAGE SPECIFICATIONS
•   Odd page numbers are printed on right-hand pages. Even page numbers are print-

ed on left-hand pages. See Figures A and B for possible page number placement.
•  Be consistent with page number placement.
•  All pages, including blank pages, should have page numbers. DO NOT allow for 

dividers in your page numbering.
•  Artwork (line art) should be at the correct size and printed onto the pages. Photos 

should be sent with the pages. (See pages 7-10 for artwork and photo instructions.)

Submitting Pages
as Hard Copy
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It is essential that these 
policies and procedures 

are followed closely; 
failure to do so may
delay the production

of your order.

And remember,
we’re always just a phone 

call away if you have a 
question or need 

assistance.

Adhere to these guidelines if you are sending a press-ready hard copy.

If you are sending pages as digital files, a hard copy is still required for proofing
purposes. Please make sure it is a current copy that matches the digital files.

WHEN PREPARING PAGES:
•   Output final pages using a letter quality laser printer at 600 dpi or higher 

resolution.
•  Output pages on white paper and only print on one side. Use laser paper, as toner 

adheres better and type prints sharper. Use only black toner.
•  Be sure the toner cartridge is full. Low toner may cause faint type or uneven 

coverage. Presses cannot adjust for variations from page to page.
•  Make sure pages are clean. This means no staples, tape, smudges, water spots, glue, 

or rips through text or artwork.
•  Submit pages and photos flat, not rolled or folded. Protect materials by placing 

them between heavy cardboard.

•   DO NOT print pages using a dot matrix printer or a color printer. The pages will 
print poorly.

•  DO NOT use paper clips on photos. They leave marks and can scratch the surface.
•  DO NOT print pages on both sides of a sheet of paper.
•  DO NOT submit pages on colored paper.

Note: If any alterations need to be made, the pages will be returned for corrections. 
Don’t forget to add page numbers. Pages should be carefully checked before they are 
submitted.

Printing a
Hard Copy
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Figure A.

Justified text:
This text is justified (flush left and flush 
right) so all lines are uniform. This text 
is justified (flush left and flush right)

Flush left text:
This text is flush left  and ragged 
right. This text is flush left and ragged 
right. This text is flush left and

Flush right text:
This text is flush right  and ragged 

left. This text is flush right and ragged 
left. This text is flush left and

Figure B.

Suggested caption sizes:
7 point

8 point

9 point

Suggested recipe text sizes:

10 point
11 point
12 point
13 point
Suggested title, headings &
subheads sizes:

14 point
15 point
16 point
17 point
18 point

WHEN WORKING WITH TYPE:
•  Justify text for a professional look. See Figure A.
•  Set recipe text in 10 to 13 point type. Text smaller than 10 point should be 

limited to captions or small bodies of text. See Figure B.
•  Set recipe titled in a larger point size than the ingredient list and instruc-

tions. This also applies to headings and subheadings in special pages. See 
Figure B.

•  To add emphasis, boldface or italicize text; DO NOT underline. 
Caution: overuse of bold or italic text will cause it to lose its effectiveness. 
Also, too many lines of italic text is hard to read.

•  DO NOT use too many typestyles. Typically, use one typeface for ingredients 
and directions and the same or a different typeface in a larger point size for 
recipe titles, headings, and subheadings. For samples of recipe pages, go to 
our website under “Designing Your Cookbook.”

•  DO NOT use script fonts in all caps, as they are difficult to read. They are 
elegant for headings and are most easily read in upper and lowercase. See 
Figure C.

•  DO NOT use typestyles with very fine lines. When printed, the fine lines 
may fill with ink or drop out completely. See Figure D.

•  DO NOT submit black bars or boxes with areas with reversed type (white 
type on a black background). They are difficult to print with consistent ink 
coverage. See Figures E and F.

•  DO NOT put screened artwork or boxes behind type or use screened type. 
See Figures G and H.

•  DO NOT use typestyles that are thick and heavy, especially in a larger point 
size. They are difficult to print with consistent ink coverage. 
See Figure I.

Tips for Typesetting
Your Cookbook

6

1-800-227-7282
www.cookbookpublishers.com

Figure C.  

DO NOT USE
SCRIPT FONT IN

ALL CAPITAL
LETTERS.

Figure F.

Reversed
Type

Figure I.

Heavy
Typestyles

Figure D.  

Very Fine Lines.

Figure G.  

Type Over
A Screened Area

Figure E.

black boxes or bars

Figure H.

Screened Type



ARTWORK REQUIREMENTS:
•  All artwork (original or clip art) is limited to ONLY line art.
•  Line art is defined as: images made only from black solid lines. Make sure they are 

sharp inked drawings and do not contain grays, screens (shading), or any color. 
Submit them on white paper only. If printing clip art from your computer, use black 
toner on white paper (see Figure A).

•  Submit line art at the correct size and printed onto the pages. If you are submit-
ting Quark®, PageMaker®, or PDF files, line art must be correctly sized (not scaled, 
but at 100%) and placed onto the pages as part of your digital files. See Document 
Specifications on page 2.

DO NOT SUBMIT THE FOLLOWING MATERIAL:
•   DO NOT submit colored clip art (see Figure B) or clip art with shading (see 

Figure C), especially those printed from a color inkjet printer.
•  DO NOT submit screened artwork (artwork with shading). This includes pencil 

drawings with shading.
•  DO NOT submit artwork with fine detail, especially if it is reduced to fit onto your 

pages. This detail will fill in or drop out when printed (see Figure D).
•  DO NOT extend (bleed) artwork or text off the page. You must stay within 

template margins (see pages 3-4).
•  DO NOT submit pages that contain artwork with large solid black areas. This in-

cludes black boxes, black bars, or thick lines (see Figure E).
•  DO NOT submit pages that contain borders around the entire page.
•  DO NOT submit artwork without a written, signed release from the copyright 

owner giving permission for their use. Generally, all artwork is copyrighted unless 
you are using royalty-free clip art, you own the images, or you paid someone to 
create artwork. Copyrighted images may include artwork from magazines, 
newspapers, books, cards, etc.

DIGITAL ARTWORK SPECIFICATIONS:
•   Line art should be scanned at 600 dpi and saved as TIFF files. Save at the size it 

will be used, not scaled in Quark®.
•  Do not rotate or flip artwork in Quark®, but rather in the graphic software in which 

it was created.
•  All artwork should be submitted in a Linking Art folder. Check Picture Usage in 

Quark® to ensure no images are missing. Photoshop™, Illustrator™, and FreeHand™ 
files are preferred.

•  If creating line art using software such as Illustrator™ or FreeHand™, line strokes 
should be a minimum of .5 point, or they may be too faint and not print.

Artwork (Line Art)
Specifications
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Figure A.
Examples of Good Line Art

Examples of Bad Line Art

B.

C.

E.

D.
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policies and procedures 
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of your order.

And remember,
we’re always just a phone 

call away if you have a 
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Follow the guidelines below when choosing photos for special pages only.

One photo is free; 2 additional photos are allowed for an extra charge (for a maxi-
mum of 3). Photos are NOT ALLOWED on recipe pages. If you want more than 3 
photos, consider using them on custom dividers. Photos will be printed in the same 
ink color as chosen for recipe pages, not in full-color.

ACCEPTABLE PHOTOS:
• In general, a good photo will make a good print.
•  Photos from a digital camera are acceptable as long as they are at the proper 

setting (see page 10 for specifications).
•  Digital photos (scanned or from a digital camera) must be at least 300 dpi.

UNACCEPTABLE PHOTOS:
•   DO NOT submit photos with large solid black areas.
•  DO NOT submit the following types of photos: 

❒ low resolution photos (under 300 dpi) 
❒ photos downloaded from the Internet (only 72 dpi) 
❒ halftones or negatives 
❒ photos from a photocopier, color copier, color inkjet or color laser printer 
❒ photos with paper clips or tape 
❒ newspaper or magazine photos 
❒ copyrighted photos (see below)

•  DO NOT submit photos without a written, signed release from the copyright owner 
giving permission for their use. Generally, all photos are copyrighted, unless you 
are using royalty-free photos, you own the images, or you paid someone to take 
photos. Examples of copyrighted photos may include photos from a professional 
photographer, newspaper, greeting cards, books, or web sites.

SUBMISSION GUIDELINES:
•  If submitting a press-ready hard copy, keep photos separate, not pasted onto pages. 

DO NOT use tape or paper clips on photos—they leave marks and can scratch the 
surface. See page 9 for instructions on how to specify placement of photos for a 
press-ready hard copy.

•  If submitting press-ready digital files for pages, photos must be correctly scanned 
and placed onto the pages at the correct size and position. If you cannot scan photos, 
send originals and we will scan and place them for you. See page 9 for instructions.

 •  DO NOT bleed (extend to the edges) photos off the page if you are submitting digi-
tal files. You must stay within the given page margins (see pages 2-3).

Photos will be output at 85 lines per inch (lpi), which is acceptable, but not high 
quality printing. It is comparable to newspaper photos.

Photo Specifications
for Special Pages
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SUBMITTING PHOTOS WITH A HARD COPY

STEP 1  Assign a number to the area on the page where the photo is to be placed. DO 
NOT draw boxes on the page to indicate placement. DO NOT place tape over photos 
or glue them to the page. Captions or bylines for photos should already be typeset on 
the page.

STEP 2  Assign the corresponding number to the photo so it matches the area it is 
to be placed. Write the number on the back of the photo pressing lightly with a soft 
pencil, not pen.

STEP 3  If photos require cropping, photocopy the photo and draw crop marks on the 
photocopy. Photos will be enlarged or reduced to best fit the space.

Repeat these steps will all photos.

SUBMITTING PHOTOS FOR DIGITAL FILES (Quark®, PageMaker® or PDF files)
•  Photos in special pages will be printed in the chosen ink color for recipe pages, not 

full-color. Therefore, save them as grayscale images, not CMYK.
•  Scan the photos at the size they will be used in Quark®. DO NOT scale them in 

Quark®. Use the following settings when scanning: 
❒ black and white photo (grayscale) 
❒ resolution 300 dpi 
❒ de-screen when necessary

•  Adjust scans in Photoshop™ using these steps: 
❒ Crop and retouch photos as needed. 
❒  Open Image/Adjust/Curves and select Auto. Move the endpoint for darks to 95% 

output. Move the endpoint for lights to 3% output. Adjust midtones by moving 
the center point down 5% for output. Photos should look slightly lighter than 
expected.

   ❒  Open Filter/Sharpen/Unsharp Mask. Adjust settings: amount = 100% (adjust as 
needed), radius = 1.5 pixels, and threshold = 5 levels.

•  Save grayscale photos as TIFF or EPS files.
•  All photos should be submitted in a Linking Art folder. Check Picture Usage in 

Quark® to ensure no images are missing.

Note: If you are unable to scan photos with the proper settings and place them into 
your Quark® or PDF files, you may submit original photos to us. We will scan and 
place them for you. Follow steps 1, 2 and 3 above.

Submitting Photos
for Special Pages
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STEP 1

# 1

# 1

STEP 2

STEP 3



It is essential that these 
policies and procedures 

are followed closely; 
failure to do so may
delay the production

of your order.

And remember,
we’re always just a phone 

call away if you have a 
question or need 

assistance.

Yes, you can take photos with your digital camera and use them in your
cookbook! With current digital technology, it is possible to take photos of acceptable 
quality for offset printing. There are three factors that determine whether your digi-
tal photos will be suitable for printing: compression, resolution and file format.

Compressed photos are NOT suitable for printing. Compression affects image quality 
and destroys image data. If your camera supports uncompressed image data such as 
TIFF or RAW, you should use those settings. If these are not available, use the low-
est possible JPEG compression ratio setting.

Resolution determines the overall quality of your digital photos. Resolution is 
expressed in megapixels or pixels in height and width. Do not rely on megapixels 
since this number does not necessarily provide a true image size. Your camera’s 
manual should list how many pixels, in height by width, it is capable of taking at full 
resolution. To find the maximum print size, divide by 300 for each axis. The result is 
the maximum dimension (in inches) that the photo can safely be printed. For exam-
ple, a camera with full resolution at 2048 x 1536 pixels would result in a 6.826 x 5.12 
inch maximum print size (each axis divided by 300).

After transferring your photo to your computer, DO NOT resize the image, alter its 
resolution, or save for web output. Save the image in TIFF or EPS format, which are 
the standard file formats for printing.

Your uncompressed image files will be several megabytes in size, so they will need to 
be copied onto a Zip™ disk or CD. If your files fit on a 3.5” floppy diskette, they most 
likely are compressed and unsuitable for printing.

Tips for Using
A Digital Camera
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If you submit your pages or 
cover as digital files, fonts 

will also need to 
be submitted. Follow these 

instructions to 
collect fonts.*

*These instructions assume that 
font management solutions such as 
Extensis® Suitcase™ are not being 
used. If font management software 
is in use, please consult your user 
documentation for more informa-

tion on collecting fonts.

IMPORTANT:
DO NOT use TrueType fonts 
when typesetting your cook-
book. Use either Type 1 or 

OpenType fonts. 

Following are guidelines 
for differentiating fonts:

TrueType (DO NOT USE)
A single file font (“font suit-
case”) found on Macintosh 

and PC platforms.

Type 1
Multiple file fonts desig-

nated as “PostScript™” and 
“font suitcase” files. Be sure 

to include all files.

OpenType
A single file font easily 

recognized by the “.otf ” 
suffix in font file name.

Sending Fonts When Using Windows XP, 2000, 98 & Windows Me:
For Windows XP:
1.  Click the Start menu and select Control Panel. The Control Panel window appears.
2.  What you see is the Windows XP Control Panel Category view. In order to send the neces-

sary fonts, change the view to Classic mode. In the upper left corner of the window, click the 
option labeled Switch to Classic View.

3.  On the right side of the Control Panel window, double-click the item labeled Fonts. A list of 
fonts on your computer appears.

4.  Locate the fonts needed for your project and select them by holding down the Control key 
on the keyboard and clicking each font once.

5.  Click the Edit menu at the top of the window and choose Copy.
6.  Close the Control Panel window and all other windows.
7.  On the Windows Desktop, click once using the right mouse button. Point to the option 

labeled New and click Folder. Type a new name of “Fonts Folder” and press the enter key.
8.  Double-click this new folder. Click the Edit menu and choose Paste. When you send us your 

work, be sure to copy this folder of fonts onto the disk with your job.

For Windows 98, Me, and 2000:
The process of sending fonts using Windows 2000, 98, or Me is virtually identical to Windows 
XP except for the following two exceptions.
1.   To bring up Control Panels, click Start, point to Settings, and click Control Panel.
2.  Windows 2000, 98, and Me do not require switching control panels to classic view.

Sending Fonts When Using Mac OS 9 or OS X:
For Mac OS 9:
1.   Close all open windows on the desktop. From the menu at the top of your screen, choose 

New Folder from the File menu. An “untitled folder” appears on your desktop.
2.  Type a new name of “Fonts Folder” and double-click this new folder to open it.
3. Double-click your hard drive’s icon.
4. Double-click the System Folder, and then double-click the Fonts folder.
5.  Locate the fonts needed for your project and copy them one by one to the “Fonts Folder”. 

This is done by holding down the Option key while dragging each font to the “Fonts Folder”. 
When you send us your work, be sure to copy this folder onto the disk with your job.

For Mac OS X:
1.  Mac OS X keeps fonts in three standard locations: 1) System: Library: Fonts; 2) Library: 

Fonts; and 3) Users: <your home folder>: Library: Fonts. 
In addition, the system also stores fonts in the Mac OS 9 “Classic” System Folder described 
above. Note: This is only if you have the Mac OS 9 Classic environment installed on your 
Mac OS X system.

2.  Locate the folder(s) that contains your fonts. Select multiple fonts by holding the Command 
(or Apple) key and clicking each font once.

3.  At the top of the screen, click the Edit menu and choose Copy. Close or minimize all 
windows on the screen.

4.  Hold down the Control key and click once on the Desktop.
5. On the menu that pops up, click the item labeled New Folder.
6. Type a new name for this folder such as “Fonts Folder.”
7.  Double-click this new folder. At the top of the screen, click the Edit menu and choose Paste. 

When you send us your work, be sure to copy this folder onto the disk with your job.

Collecting &
Submitting Fonts
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